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How to Make Your First Game with Godot 

Introduction 

 

Are you eager to get started making your own games? 

 

Game development has never been more popular before - with sales stretching into the billions, 

and thousands of indie developers sharpening their skills and bringing their creations to life. 

Even if you're a beginner who has never coded before, with numerous engines available, just 

about anybody can create and program their dream game project. 

 

In this comprehensive tutorial, we're going to be learning how to create your first game using 

Godot, a free, open-source game engine that allows you to create 2D and 3D games.  Due to its 

open-source nature, which means users can add and remove things from the engine at their 

leisure, it has quickly been gaining vast popularity.  With a vibrant community ready to assist, it 

is a perfect choice for creating your first game. 

 

After installing Godot and learning the basics of the editor, we're going to be creating a 2D 

platformer game, so strap yourself in and get ready to start developing games! 
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Project Files 

 

For this project, we're going to be needing a few assets for the player, tiles, coins, enemy, etc. 

You can create your own or use the ones featured in this tutorial. The assets can be 

downloaded here. 

 

You can also download the completed Godot project via the same link! 

 

Installing Godot 

 

To download and install Godot, let's go over to https://godotengine.org/. Here, you can view 

Godot's features, community pages and more. We want to click on the Download button. 

 

 

 
 

 

Select your platform, then download the 64 or 32 bit standard version (depending on your 

operating system). 
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This will download a .ZIP file. Inside of that is an application which you can extract to anywhere 

on your computer, and that's it - Godot is installed. 

 

Creating a New Project 

 

Open up the Godot application we download to see the Project Manager. Here, we can create 

projects, view others and download templates. 

 

Click on the New Project button to create a new project. 
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This will open up a new window. 

 

1. Enter in a name for your project 

2. Click the Create Folder button to create a new folder for the project in the Documents 

folder 

3. Click the Create & Edit button to launch the engine and begin creating the game 
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Exploring the Editor 

 

When the editor pops up it may look pretty daunting with all the buttons and options, but let's 

break it down. 

 

 
 

Godot has 4 main panels which we'll be using to create our game and each serves a specific 

purpose. 

 

1. This here is the Scene panel. It will display the node layout and hierarchy of the scene 

we're currently in. We'll go over what a scene and a node are very shortly. 

2. The FileSystem panel shows us all of the assets and files we have. Sprites, models, 

scripts, scenes, folders, audio, etc. 

3. This is where we can see and create our game. Moving things around, selecting, 

scripting, etc. Above this panel are four buttons and they toggle what the panel 

becomes. We can switch between 2D and 3D modes, the script editor and external 

asset library. 

4. This is the Inspector and this shows us the details of a node when we select one. The 

position, rotation and any other attributes which we can modify. 
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How Godot Works 

 

Above we were talking about scenes and nodes. What are they? Well, a game in Godot is made 

up of a hierarchy of nodes. A node can be anything: a player, camera, 3D model, light, UI, etc. 

Nodes make up all of the entities in your game and also have the ability to be a child of another 

node. 

 

Here's an example of a player in a game. First, we have the KinematicBody node which can 

control movement and some physics interactions. Then, as a child of this, we have a collider 

and sprite node. When the kinematic body node moves, rotates, etc, the others will follow. Even 

if we delete the parent node, the children will follow. 

 

 
 

Games in Godot are made up of many parent-children nodes to create the various different 

elements and systems of a game. 

 

Since a game is made up of nodes, it will eventually get to a point where there are hundreds or 

even thousands of them in the scene tree panel. This will make it hard to find certain ones and 

overall make working on the game confusing. To solve this issue, we can divide up our nodes 

into scenes. 

 

Scenes are self-contained node packages which we can then drop into other scenes as nodes. 

Let's take our player example and turn that node hierarchy into a scene. It is a saved file in the 

FileSystem which we can then drag into another scene. 
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A benefit of dividing your game up into nodes is also the fact that we can remove the need to 

repeat common node structures. Instead of having 100 tile nodes which all have a sprite, 

collider, etc all in the same scene, we can just create one of those as a scene and drag in 

multiple instances. 

 

We'll be exploring nodes and scenes throughout this project. 
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Creating our First Scene 

 

Alright, let's get started on our 2D platformer project. First, we'll need to create a main scene 

which will be the basis for our game, containing other scenes such as the player, tiles, coins, 

and enemies. 

 

In the scene panel, click on the 2D Scene button to create a new 2D scene. 

 

 

 
 

 

With our new node, let's double click it and rename it to MainScene. 
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It's also good to save your scenes when you create them. Save with either Ctrl + S or Scene > 

Save Scene. Hit enter and you should see it down in the file system. 

 

 
 

Creating the Player 

 

Alright, we got our main scene. Next, let's go and create our player scene which will hold all the 

nodes we need and the corresponding script. 
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To create a new scene, we can go Scene > New Scene. In the scene panel, select Custom 

Node. This will open a window and we want to create the KinematicBody2D node. 

 

 

 
 

 

Rename the node to Player, then save it. 
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With our platformer game, we'll be needing a few sprites and other assets. Included with this 

tutorial, is a .ZIP file containing all the assets we'll need. Download that and drag the three 

folders into our Godot project folder. 

 

 
 

Back in Godot, let's right-click on the Player node and select Add Child Node. We want to add 

in a CollisionShape2D node as a child. Then in the file system, find the Player_Idle image and 

drag that into the scene window to add that as a child node. Rename that node to Sprite. 
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We want our sprite to be centered, so select it and over in the Inspector: 

 

• Open the Transform drop-down 

• Set the Position to 0, 0 

 

 
 

You might see that the collision node has an error symbol next to it. This means we need to give 

it a shape. Select the collision node and in the inspector set the Shape to Capsule. To make it 

visible, re-order the node hierarchy by dragging the collider node underneath the sprite node. 
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To edit the collider properties, select the shape in the inspector and it will open up more options. 

 

• Set the Radius to 27 

• Set the Height to 12 

• Set the Position to -0.5, 14.7 

 

 
 

Scripting the Player 

 

Now that we have the node structure setup, we can begin to script our player. This will involve 

the movement, jumping and collecting coins. 

 

To create a script, select the parent Player node and in the Inspector, create a new script. This 

will open up another window, just hit enter. 
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What you'll see then is that the main window will switch from 2D to Script mode. 
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Godot uses its own scripting language called GDScript. This is similar in syntax to Python. We 

won't be going over every aspect of the language or the basic concepts of programming - so a 

basic understanding is required going forward. 

 

Right now in the script we have two things. 

 

 
 

Extends is similar to using or import. We're extending from the kinematic body 2D object we're 

attached to, so we'll have direct access to those attributes. 

 

 
 

This is a function that is basically a block of re-usable code we can call. The _ready function is 

built into Godot and gets called once when the node is initialized. 

 

The pass is simply a filler line to define the function. If it's empty then an error will occur. The 

pass does nothing. 

 

We're going to start by adding in some variables. 
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A Vector2 defines an x and y value which can be used for position, scale, rotation, velocity. 

We're going to be using it to store our player's current velocity. 

 

We need one more variable. This is a reference to the sprite component which is a child 

node. onready means that we're going to find the Sprite node when the node is initialized. 

 

 
 

 

Now that we have our variables defined, let's start to get our player moving. To do this, we first 

want to define some key inputs. Open the Project Settings window (Project > Project Settings) 

and in there, navigate to the Input Map tab. 

 

In the Action field, enter in a name for the input and click add. 

 

 

 
 

 

We want to create 3 new actions. 

 

• move_left 

• move_right 

• jump 
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Next to each action is a '+' icon. Click that, then select Key. This will allow us to enter in a key 

for that action. 
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Enter in a new key for each of the three actions. 

 

 
 

Once that's done, we can close the window and continue scripting. 
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We're now going to create a function which is built into Godot. The _physics_process function 

gets called 60 times a second and is what we use for physics calculations. We can remove 

the pass once we start filling the function in. 

 

The delta parameter is the time between each frame. We can multiply our movement by this in 

order to move based on pixels per second, rather than pixels per frame. 

 

 
 

First, we want to reset the horizontal velocity. Then check for the left and right movement key 

inputs. These will change the horizontal velocity. 

 

 
 

Next, we'll move the player using the move_and_slide function which will move along a certain 

velocity, detecting colliders and other things. The second parameter is the ground normal (which 

way is the ground pointing?). 

 

 
 

After this, we can apply gravity and check for if we're pressing the jump button and on the floor. 

If so, jump. 
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Finally, we can flip the sprite depending on which way we're moving. 

 

 

 
 

 

We're done scripting for now, so let's switch back to 2D mode and go to the MainScene. Here, 

we want to drag in the Player.tscn scene from the file system. 
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What we can do now is test the game out. In the top right corner of the screen, click the Play 

button. 
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A window will pop up saying that there's no main scene selected. Click the Select button and 

select the MainScene.tscn scene as the default one. 

 

The game should then open up but we'll quickly fall off-screen due to gravity. What we need to 

do is create a tile scene which we can then duplicate in the main scene. 

Creating a Tile 

 

Let's now create a new scene (Scene > New Scene), select Custom Node and search for 

the StaticBody2D node. This is a physics node which is static so it doesn't move or do anything 

but detect collisions. 

 

1. Rename the node to Tile 

2. Attach a new CollisionShape2D child node 

3. Set the Shape to Rectangle 

4. Set the Extents to 32, 32 

5. Drag in the Tile image from the file system to create a new sprite node 

6. Rename it to Tile 

7. Set the Position to 0, 0 

8. Save the scene as Tile.tscn 
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Back in the MainScene, we can drag the tile scene in. Then duplicate it with Ctrl + D and move 

it around. 

 

 
 

To make it easier to position the tiles, we can turn on snapping. At the top left of the scene 

panel, click on the snap button to toggle it. Then click on the three dots to bring up the snap 

settings. Make sure only Use Pixel Snap is selected. Now when we move a tile around, it will 

snap based on the pixels. 
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Now we can press play and test it out on our new level. 

 

Creating an Enemy 

 

Create a new scene with a root node of Area2D. As a child attach a collision shape 2D node in 

the shape of a circle and drag the Enemy sprite in too (make sure to center it). Then save the 

scene as Enemy.tscn. 

 

 
 

Select the Area2D root node and create a new script called Enemy. 

 

First, we want to create the variables. 
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export means that this variable is exposed in the inspector, allowing us to change the property 

on the instance of the scene. 

 

Then in the _physics_process function, we're going to be moving between the startX and 

targetX positions. The move_to function is our own custom function we'll make after. 

 

 

 
 

 

The move_to function translates a given value to a target based on a given step. 
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Back in the MainScene, drag the Enemy.tscn into the scene. Figure out the distance between 

the enemy and where you want to move to and set that in the Move Dist property. 

 

https://academy.zenva.com/product/godot-game-development-mini-degree/?zva_src=godottutorials-godotbeginners-ebook


 
This book is brought to you by Zenva - Enroll in our Godot Game Development Mini-Degree to master 2D 

and 3D game development with the free, open-source Godot game engine 

© Zenva Pty Ltd 2020. All rights reserved 

 

 
 

We can now press play and see the enemy in action. You may notice that it's quite slow, so let's 

set the Speed to 500. 

Colliding With the Enemy 

 

Right now, the player can walk through the enemy with no issue. What we want, is for the game 

to reload if we hit the enemy. To do this, we need to work with signals. These are events that 

can be called when a certain thing happens to a node. 

 

In the Enemy scene, select the root Area2D node and in the Inspector, switch to the Node tab. 

Here, we can see all the signals that the node can emit. We want to double click on 

the body_entered signal. Press enter and it should create a new function in the Enemy script. 
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In this function, we're going to check if the body we entered was called Player. If so, call the die 

function on that node. 

 

 
 

Let's now go to the Player script and create the die function. 
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Now when the player hits the enemy, the scene will reload. 

Collecting Coins 

 

We want the player to achieve a certain goal, so let's add in some coins. Before we create the 

scene, let's go and set up the scripting side of things over in the Player script. 

 

The collect_coin function gets called when we run into a coin and increments our score by the 

given parameter value. 

 

 

 
 

 

Next, create a new scene and make the root node an Area2D. Give it a collision shape node as 

a child with the shape being a circle. Then drag in the Coin sprite and center it. 
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On the Area2D root node, create a new script called Coin. This is just going to detect when a 

player has entered the collider, then call the collect_coin function. 

 

We'll start with our only variable which is just the value of the coin. 

 

 
 

The _process function is built into Godot and gets called every frame. We're going to use it in 

order to rotate the coin over time. 

 

https://academy.zenva.com/product/godot-game-development-mini-degree/?zva_src=godottutorials-godotbeginners-ebook


 
This book is brought to you by Zenva - Enroll in our Godot Game Development Mini-Degree to master 2D 

and 3D game development with the free, open-source Godot game engine 

© Zenva Pty Ltd 2020. All rights reserved 

 

 
 

Next, we need to select the Area2D node, in the Inspector go to the Node tab and double-click 

on the body_entered signal to attach it to the script. 

 

 
 

Back in the script, we can fill in the function to check if the entering body is the player. If so call 

the collect_coin function and destroy the coin. 
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In the main scene, we can now drag in the coins to populate the level. 

 

 
 

Tracking Camera 

Right now our camera is static, so let's implement the ability for the camera to move 

horizontally. 

 

The camera is a new node we'll create as right now, the game is being rendered just based on 

the position of the nodes and pixels, not the position of the camera. So in the MainScene, right 

click on the parent node and create a new child node of type Camera2D. 
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• Enable Current so that the camera will be active 

• Move the camera to cover the level 

 

 
 

Now we can create a new script on the camera node called CameraController. 

 

First, we want to create a variable to store a reference to the player in order to track 

them. get_node will search for a node based on the given path. 

 

 
 

Then in the _process function (called every frame), we can set our X position to be the same as 

the player's. 
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Now when we press play, you'll see that the camera follows along the player's X position. 

Except that it does act a bit weird. Select the camera and in the Inspector, set the Drag 

Margins to 0, 0, 0, 0. This means that there's no margin for us to move around freely, the 

camera will always be tracking our X position. 
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Press play and you should see that it's all working fine now. 

UI 

 

Now that we have the game pretty much done, all we need to do is add in some sort of user 

interface to show us our current score. 

 

To begin, create a new scene with the root node being User Interface (control). 

 

1. Rename the node to UI 

2. Save the scene 

 

You'll see that there is a colored rectangle. This is the bounds of the control node which is how 

we build our UI elements. 

 

 
 

This rect right now is covering the whole screen. Let's add in two new things. 

 

• A coin icon 

• A text box to show our current score 
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Let's start with the icon. Create a new child node of type TextureRect. This is a control node 

where we can show an image. In our file system, find the coin image and drag that into 

the Texture field in the inspector. 

 

Also set the Position to 20, 20. 

 

 

 
 

 

Then for the text, we want to create a new child node of type Label. This is a control node 

where we can display text. 

 

1. Rename it to ScoreText 

2. Set the Position to 90, 20 

3. Set the Size to 100, 64 
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Right now we can't see our text, and that's because we need a font. There is a default font but 

it's quite limiting so we'll setup our own. 

 

In the file system, open the Font folder, right click on the font file we have and select New 

Resource... Find the DynamicFont resource and create that. 
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Select our new resource and in the inspector, drag the .ttf font file into the Font Data property to 

assign it. 

 

 

 
 

 

Under the Settings tab, set the Size to 40. 
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Select the ScoreText and under the Custom Fonts tab, drag in our new dynamic font resource. 
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We can now type in a placeholder number up in the Text property. To make the text centered 

vertically, set the Valign property to Center. 

 

 
 

Alright, we've got our UI setup. If we go to the MainScene we can drag the UI scene into the 

node list and it should appear. 

 

 

https://academy.zenva.com/product/godot-game-development-mini-degree/?zva_src=godottutorials-godotbeginners-ebook


 
This book is brought to you by Zenva - Enroll in our Godot Game Development Mini-Degree to master 2D 

and 3D game development with the free, open-source Godot game engine 

© Zenva Pty Ltd 2020. All rights reserved 

 

 

If you press play though, you'll see that it doesn't follow the camera. To fix this, we need to 

make this UI scene a child of a new node called CanvasLayer. This node defines what gets 

rendered onto the screen as UI. 
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Scripting the UI 

 

All that's left to do is connect the UI to a script. In the UI scene, create a new script called UI and 

attach it to the parent node. 

 

First, we need to create a variable which will get the score text node upon starting the game. 

 

 
 

Then in our only function, we'll set the score text to whatever the parameter sends over. 

 

 
 

Over in the Player script, let's create a variable to reference the UI node. 

 

 
 

Then down in the collect_coin function, let's add a line of code to set the UI text. 

 

 
 

If we press play now the score text will update when we collect a coin. Let's also set it up so that 

the text is set initially when the game begins. In the UI script... 

 

 
 

Now the text should be set to 0 when we start the game. 
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Conclusion 

 

And that's it!  If you hit Play on your Godot project now, everything should work. Congratulations 

on completing your first game! 

 

We now have a functional 2D platformer with a playable character, coins, UI, and a dangerous 

enemy to obstruct our path.  While you can certainly improve upon this framework to add even 

more challenges, you've no doubt seen how the foundations of the framework taught here will 

provide a useful starting point as you increase your game development skills further.  The sky is 

truly the limit, and you can expand as needed to create new game projects with these 

fundamentals. 

 

Either way, you've taken the first crucial step and created your first game!  We wish you luck in 

the future, and we can't wait to see the sorts of games you create! 
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Create a First-Person Shooter in Godot - Part 1 

Introduction 

 

Welcome to the tutorial, and get ready to learn some in-demand skills for creating first-person 

shooter games!   Throughout this tutorial, we will work with the 3D aspects of the Godot game 

engine to enhance your foundations when it comes to action game development.  Additionally, 

we'll be creating a first-person shooter from scratch, which will show you how to set up the FPS 

player and camera, enemies, efficient shooting mechanics, health and ammo pickups, and 

more. 

 

Before we begin, it's important to know that a basic understanding of the Godot engine is 

required. If this is your first time using Godot, I recommend you read through the How to Make 

First Game with Godot chapter first. It will teach you how to install Godot, and the basics of the 

engine and GDScript. 

 

 

Project Files 

For this project, we'll be using a handful of pre-made assets such as models and textures. 

Some of these are custom-built, while others are from kenney.nl, a website for public domain 

game assets. 

 

The assets can be downloaded here. 
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You can also download the completed Godot project via the same link! 

Let's Begin 

To begin, create a new Godot project. We have a few assets such as models and textures we'll 

be using (download above), so let's drag the Font, Models and UI folders into the FileSystem. 

 

 
 

Now that we have our assets, let's create our first scene by going to the scene panel and 

selecting the 3D Scene option. 

 

1. Rename the node to MainScene. 

2. Save the main scene to the file system. 
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Building Our Environment 

The first thing we're going to do is create our environment so we have somewhere for the player 

to exist. In our Models/Environment folder, we have a Ground model. Drag that into the scene 

window to create a new MeshInstance node. Set the position to 0. 
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The MeshInstance node will render a model, but that's it. In our case, we want the player to be 

able to collide with the ground, otherwise they'd sink through. 

 

So to do this, we can select the ground node and in the scene panel, select Mesh > Create 

Trimesh Static Body. 

 

 
 

This will create two children nodes. 

 

• StaticBody: static physics object which can detect collisions 

• CollisionShape: defines the shape and dimensions of the object's collider 
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With this node, we can change the position, scale and rotation. Go ahead and create an 

environment. 

 

 

 
 

 

One thing you may notice, is that the node structure is starting to get quite long and convoluted 

since we have a lot of models. To fix this, we can create a new node as a container and store 

the models in as children. 

 

Create a new node of type Node as a child of the MainScene. Drag the model nodes inside to 

make them children. Now we can visually open or close the node container. 
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Another thing you might notice is that the scene is quite dark. To fix this, we can add in a 

directional light which will act like a sun. 

 

1. Create a new node of type DirectionalLight. 

2. Enable shadows. 

3. Set the Rotation Degrees to -60, 45, 0. 
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Creating the Player 

 

Now we can create the player. Create a new scene with a root node of KinematicBody and 

rename it to Player. We can then save the scene. 
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Let's add a CollisionShape node to detect collisions. 

 

1. Set the Shape to Capsule 

2. Set the Radius to 0.5 

3. Set the Height to 1.5 

4. Set the Translation to 0, 1.25, 0 

5. Set the Rotation to 90, 0, 0 

 

 

 
 

 

Next, add a new Camera node. This will allow us to see through the player's eyes. 

 

1. Set the Environment to default_env.tres (found in file system) 

2. Enable Current 

3. Set the Translation to 0, 0.25, 0 
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For the gun, drag the shotgun.obj model into the scene and make it a child of Camera. To see 

through the camera's perspective, select the camera and in the scene view toggle the Preview 

option (top left of the window). 

 

1. Rename the node to GunModel 

2. Set the Translation to 0.2, -0.2, -0.7 

3. Set the Rotation Degrees to 0, -180, 0 

4. Set the Scale to 10, 10, 10 

 

 

https://academy.zenva.com/product/godot-game-development-mini-degree/?zva_src=godottutorials-godotbeginners-ebook


 
This book is brought to you by Zenva - Enroll in our Godot Game Development Mini-Degree to master 2D 

and 3D game development with the free, open-source Godot game engine 

© Zenva Pty Ltd 2020. All rights reserved 

 

 

The gun also needs a muzzle so we know where to spawn the bullets. Create a new Spatial 

node as a child of GunModel. 

 

1. Enable Use Local Space (shortcut = T) so that the gizmos are orientated in local space 

2. Rename the node to Muzzle 

3. Position the node in front of the gun 

 

 

 
 

 

Back in the MainScene, let's drag in the Player.tscn to create a new instance of the Player 

scene. 
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With this here, we can press the play button (make the MainScene the main scene) and you 

should be looking through the player's eyes. 

 

Finally, before we begin scripting, let's set up our input actions. Open the Project Settings 

window (Project > Project Settings) and go to the Input Map tab. Create a new action for: 

 

• move_forward (W key) 

• move_backward (S key) 

• move_left (A key) 

• move_right (D key) 

• jump (Space key) 

• shoot (Left Mouse Button) 
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Scripting the Player 

 

Now that we have our player scene setup, let's get to scripting the player movement, jumping, 

gravity, shooting, etc. 

 

In the Player scene, create a new script on the Player node. By default, it should be called 

Player.gd. We'll begin by filling in our variables. 
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First, we can begin by setting up the ability to look around. The _Input function is built into 

Godot and gets called whenever an input is detected (keyboard, mouse click and movement). 

What we're doing here, is getting the direction and length that our mouse moved. 
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Next, we'll create the _process function. This is built into Godot and gets called every frame. 

Here, we're going to use that mouseDelta vector and apply that to the camera and player 

rotations. 

 

 
 

We can now press Play and see that we look around when we move the mouse. 

 

Next up is movement. This will all be done in the _physics_process function. It's built into the 

KinematicBody node and gets called 60 times a second (good for physics). 

 

 
 

First, we're going to check for our keyboard inputs. 
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Next, we need to get the forward and right direction of our player, so we know which way we're 

facing and can apply that to our velocity. 

 

 
 

We can then set our velocity, apply gravity and move the player! 
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Finally, we're going to check for the jump action and change the Y velocity when that happens. 

 

 
 

If we press the play button now, you'll be able to move, look around and jump. That's how to 

create a basic first-person controller in Godot. Now let's get working on the rest of the game. 

 

Creating the Bullet Scene 

Before we start to script the ability to shoot, we need to create a scene for the bullet. Create a 

new scene with a root node of Area. This is a node which can detect physics collisions. 

 

1. Save the scene to the FileSystem. 

2. Drag the ammo_pistol.obj model into the scene as a child of Bullet. 

3. Set the model's Scale to 10, 10, 10. (not in image) 

4. Set the model's Rotation Degrees to 90, 0, 0. (not in image) 

5. Attach a new CollisionShape node. 

6. Set the Shape to Capsule 

7. Set the Radius to 0.03 

8. Set the Height to 0.07 
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On the Bullet node, create a new script called Bullet.gd. We'll start of with the variables. 

 

 
 

Inside of the _process function, we'll move the bullet forwards at a rate of speed units per 

second. 

 

 
 

Now it's time to detect if we're hitting something. Select the Bullet node and over in the 

inspector, click on the Node tab to see all of the signals that the node emits. A signal is like an 

event which can call a function when something happens. In our case, we want to connect 
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the body_entered signal to our script. This gets called when the collider enters another node's 

collider. 

 

Double click on that signal and hit enter. A new function should have appeared in the bullet 

script. 

 

We're going to check if the body we hit has a function called take_damage. We haven't created 

this yet, but we will do it soon. If so, deal the damage and destroy the bullet by calling the 

destroy function. This is a custom function we're going to create right after this one. 

 

 
 

The destroy function will simply destroy the bullet instance. 

 

 
 

We now have a bullet which will move forward and damage whatever it hits (yet to be added). 

Let's also add in something so that the bullet can't travel forever if it misses its target. 

 

In the Bullet scene, create a new node of type Timer. This node will count up and when it hits a 

certain amount, we'll call the destroy function. 

 

1. Set the Wait Time to 5 

2. Enable Autostart 
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Over in the node tab, let's connect the timeout signal to our script. This gets called once the 

wait time has been reached. Double click on the timeout signal and a window will pop-up. 

Change the Receiver Method to destroy. This will connect the signal to our existing function. 
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Shooting Bullets 

 

Now that we have our bullet, let's implement the ability to shoot it. Over in the Player script, let's 

create some new variables to keep track of our components. 

 

 
 

Down in the _process function, let's check for when the shoot action is pressed. 

 

 
 

The shoot function will spawn a new instance of the bullet scene and position it. 

 

 
 

If you want the mouse to be locked when we're playing the game, we can do so in the _ready 

function which gets called when the node is initialized. 
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We can now press play and test it out. 

Creating the Enemy 

Create a new scene with a root node of KinematicBody. 

 

1. Rename it to Enemy. 

2. Save the scene. 

3. Attach a new node of type MeshInstance. 

4. Rename it to Model. 

5. Set the Mesh to capsule. 

6. Set the Radius to 0.5. 

7. Set the Mid Height to 1.5. 

8. Rotate and re-position the mesh so that it is orientated like below. 
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In the MeshInstance node, you'll see a Material property which is empty. Select it and 

click New SpatialMaterial. 

 

1. Set the Albedo Color to red. 

 

 
 

Let's then attach a new CollisionShape node and make it match the mesh. 
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Finally, we'll attach a Timer node to the enemy. This is going to be used in order to attack the 

player. 

 

 
 

Continued Part 2 

 

And that's where we'll conclude for the time being! 

 

At this point, we've learned several essential foundations for setting up a first-person shooter in 

Godot.  First, we established our arena where all the action will take place.  We then created a 

player, along with a camera, which is scripted to follow the mouse movements as we move the 

player around.  To this player, we also added a gun model that can shoot bullets - which we 

also created with performance in mind. Lastly, we set up our enemy model and learned a bit 

about materials in the process. 

 

Of course, there is still more needed to complete our FPS!  In Part 2 of this tutorial, we will finish 

up building our Godot FPS by implementing the enemies' movement, setting up ammo and 

health pickups, and polishing everything off with a nifty UI!  We hope to see you there. 
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Create a First-Person Shooter in Godot - Part 2 

 

Introduction 

 

Welcome back, and I hope you're ready to finish creating our Godot FPS tutorial. 

 

In Part 1, we set up our arena, our player character, our FPS camera, our gun, our bullets, and 

even our red enemies.  However, while we certainly implemented the shooting mechanics, our 

enemies can't yet damage players, get damaged themselves, or move.  In addition, we have no 

pickups to speak of, let alone a UI to give the player essential health and ammo information.  As 

such, in this tutorial, we will be jumping into setting those up. 

 

By the end, you will have not only learned a lot about 3D game development, but also have a 

nifty FPS to add to your portfolio! 

 

Project Files 

 

For this project, we'll be using a handful of pre-made assets such as models and textures. 

Some of these are custom-built, while others are from kenney.nl, a website for public domain 

game assets. 

 

The assets and source code can be downloaded here. 

 

Scripting the Enemy 

Create a new script on the Enemy node. Let's begin with the variables. 
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In the _ready function, we'll set up the timer to timeout every attackRate seconds. 

 

 
 

If we select the Timer node, we can connect the timeout signal to the script. This will create 

the _on_Timer_timeout function. We'll be working on this later on. 

 

 
 

In the _physics_process function, we'll move towards the player. 
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The take_damage function gets called when we get damaged by the player's bullets. 

 

 
 

The die function gets called when our health reaches 0. The add_score function for the player 

will be added soon. 
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The last function to add is the Attack function. We'll be creating the player's take_damage 

function soon. 

 

 
 

Finally in the _on_Timer_timeout function, we can check the distance to the player and try to 

attack them. 

 

 

Player Functions 

 

In the Player script, we're going to add in a number of functions which we need right now and in 

the future. The die function will be filled in later once we have our UI setup. 
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Now we can go to the MainScene and drag the Enemy scene into the scene window to create 

a new instance of the enemy. Press play and test it out. 

Pickups 

For our pickups, we're going to create one template scene which the health and ammo pack will 

inherit from. Create a new scene with a root node of Area. 
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2. Rename it to Pickup. 

3. Save the scene. 

4. Attach a child node of type CollisionShape. 

5. Set the Shape to Sphere. 

6. Set the Radius to 0.5. 

 

 
 

Next, create a script on the Pickup node. First, we'll create an enumerator which is a custom 

data type that contains different options. 

 

 
 

Then for our variables. 
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In the _process function, we're going to make the pickup bob up and down. 

 

 
 

Select the Pickup node and connect the body_entered node to the script. 
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The pickup function will give the player the appropriate stat increase. 

 

 

 
 

 

Now that we've finished the script, let's go back to the scene and you'll see that the Pickup 

node now has two exposed variables. 
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We're now going to create two inherited scenes from this original Pickup one. Go to Scene > 

New Inherited Scene... and a window will pop up asking to select a base scene. Select 

the Pickup.tscn and a new scene should be created for you. You'll see that there's already the 

area and collider nodes there since they are a parent. This means any changes to the original 

Pickup scene, those changes will also be applied to the inherited scenes. 

 

All we need to do here is... 

 

• Rename the area node to Pickup_Health 

• Set the pickup type to Health 

• Drag in the health pack model 
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We also want to do the same for the ammo pickup. 

 

 
 

Back in the MainScene, we can drag in the Enemy, Pickup_Health and Pickup_Ammo scenes 

and place them around. 
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UI 

 

Now it's time to create the UI which will display our health, ammo, and score. Create a new 

scene with the root node being User Interface (control node). 

 

• Rename the node to UI 

• Create a new child node of type TextureProgress 

• Enable Nine Patch Stretch 

• Rename it to HealthBar 

• Move the health bar to the bottom left of the screen and re-size it 

• Drag the 4 anchor points (green pins) to the bottom left of the screen 

• Set the Under and Progress textures to the UI_Square.png image 

• Set the Tints as seen in the image. 

 

 

 
 

 

For the text, we need to create a new dynamic font resource. In the file system, find 

the Ubuntu-Regular.ttf file - right click it and select New Resource... 
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• Search for and create a DynamicFont 

• In the inspector, set the Font Data to the ubuntu font file 

• Set the Size to 30 

 

 

 
 

 

Now we can create the text elements. Create a new Label node and call it AmmoText. 

 

• Resize and position it like in the image below 

• Set the Custom Font to the new dynamic font file 

• Move the anchor points down to the bottom left 
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With the node selected, press Ctrl + D to duplicate the text. 

 

• Rename it to ScoreText 

• Move it above the ammo text 
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Scripting the UI 

 

Now that we have our UI elements, let's create a new script attached to the UI node called UI. 

 

First, we can create our variables. 

 

 
 

Then we're going to have three functions which will each update their respective UI element. 

 

 
 

So we got the functions to update the UI nodes. Let's now connect this to the Player script. 

We'll start by creating a variable to reference the UI node. 
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Then in the _ready function, we can initialize the UI. 

 

 

 
 

 

We want to update the ammo text in both the shoot and add_ammo functions. 

 

 

 
 

We want to update the health bar in both the take_damage and add_health functions. 

 

 

 
 

We want to update the score text in the add_score function. 

 

 

 
 

 

And now we can go back to the MainScene and create a new node called CanvasLayer. 

Whatever is a child of this, gets rendered to the screen so let's now drag in the UI scene as a 

child of this node. 

 

https://academy.zenva.com/product/godot-game-development-mini-degree/?zva_src=godottutorials-godotbeginners-ebook


 
This book is brought to you by Zenva - Enroll in our Godot Game Development Mini-Degree to master 2D 

and 3D game development with the free, open-source Godot game engine 

© Zenva Pty Ltd 2020. All rights reserved 

 

 
 

Now we can press play and see that the UI is on-screen and updates when we take damage, 

collect pickups, and kill enemies. 

Conclusion 

Congratulations on completing the tutorial! 

 

If you've been following along, you should now have a complete Godot FPS game at your 

fingertips.  Players will be able to fire on enemies, gather pickups for ammo and health, and 

even potentially be defeated by our menacing red capsules!  Not only that, but you also have 

boosted your own knowledge in how Godot's 3D engine works and how you can utilize 3D's 

unique features in a number of ways.  Of course, from here, you can expand upon the FPS 

game we created in any way you please - adding in new systems, models, sound, etc. 

 

Thanks for following along, and I hope to see you in the next Godot tutorial. 
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Build a 2D RPG in Godot - Part 1 

 

Introduction 

 

Welcome, everyone!  Even after all the years games have existed, RPGs are still one of the 

most popular genres that aspiring developers want to learn how to make.  However, given how 

feature-rich RPGs can be, it can be hard to know where to start.  Thankfully, though, with Godot 

and some programming knowledge at hand, you will have all the tools you need to start on your 

very own dream RPG! 

 

In this RPG tutorial series, we'll be creating a 2D RPG inside of the Godot game engine 

together. It will feature a top-down player controller, enemies, combat, loot, and even a leveling 

system.  For Part 1, though, we will be covering a number of new systems inside of Godot as 

we start to build our RPG, including tilemaps, sprite animations, and raycasting.  This course will 

require a basic understanding of the Godot game engine and the GDScript scripting language. If 

you're new to Godot, you can view our introductory tutorial here. 

 

Otherwise, though, we hope you strap in and are ready to learn how to make 2D RPGs with 

Godot. 

 

If you'd like to jump straight in making enemies and loot, check out Part 2 instead! 
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Project Files 

For this project, we'll be needing some assets such as sprites and a font. These will be sourced 

from kenney.nl and Google Fonts. You can, of course, choose to use your own assets, but for 

this course we'll be using these. 

 

The assets and source code can be downloaded here. 

Setting Up The Project 

To begin, let's create a new Godot project. Inside of the editor, let's then import the assets we'll 

be needing. 

 

 
 

Once we have the assets, let's create our first scene by selecting 2D Scene in the scene panel. 

Rename this node to MainScene, then save the scene to the file system. 
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Creating the Player 

Now that we have the main scene, let's create a new scene (Scene > New Scene) of 

type KinematicBody2D. 

 

• Rename the node to Player 

• Save the scene to the file system 

 

As a child of this node, we want to... 

 

• Drag in the player_s_0.png sprite in to create a new sprite node 

• Set the position to 0, 0 

• Create a child node of type CollisionShape2D 

• Set the Shape to Capsule 

• Resize it to fit the sprite 

 

Right now, we're using just a sprite node to allow us to see the player. Later on, we'll be 

replacing this with an AnimatedSprite node. 
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Finally, for our player, let's create a RayCast2D node. You'll see that in the scene view, an 

arrow will appear to come out of the player. This is a raycast, which is a concept in game 

development that is used in many different cases. You give a raycast an origin position and a 

direction. Then it will shoot a point from that origin in the given direction. If that point ever hits a 

collider it will return that object and some other information. 

 

In our case, the raycast has a max distance and this will be used to detect interactable objects 

and enemies. 

 

• Make sure to enable Enabled 
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Scripting the Player Movement 

 

Now that we have the player scene, let's create a new script attached to the kinematic body 

node called Player. We can start with our variables. 

 

 
 

 

Later on, we'll be adding in a couple more variables, but for most of our systems, this will do. 

Now, in order to move the player around, we'll need to know which buttons do what. Go to the 

Project Settings window (Project > Project Settings...) and click on the Input Map tab. Here, 

we want to create 5 new actions and assign a keyboard key to each of them. 

 

 

https://academy.zenva.com/product/godot-game-development-mini-degree/?zva_src=godottutorials-godotbeginners-ebook


 
This book is brought to you by Zenva - Enroll in our Godot Game Development Mini-Degree to master 2D 

and 3D game development with the free, open-source Godot game engine 

© Zenva Pty Ltd 2020. All rights reserved 

 

• move_left - left arrow key 

• move_right - right arrow key 

• move_up - up arrow key 

• move_down - down arrow key 

• interact – space 

 

 
 

Back in the script, we can create the _physics_process function. A built-in function which runs 

at 60 FPS (good for physics). What we want to do here, is a few things. 

 

1. Reset vel (vector containing our velocity) 

2. Detect the 4 direction keys to change the velocity and facing direction (used for 

animations later) 

3. Normalize the velocity vector to prevent faster diagonal movement 

4. Move the player based on the velocity using the KinematicBody2D node function 
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Let's hop over to the MainScene and test the movement out. In the file system, drag the player 

scene into the scene window to create a new instance of it. Then click the Play button, choose 

the main scene to be the base scene and see if the movement works. 
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Animating the Player 

 

You'll see that we can move around, but it's pretty bland. Let's now implement sprite animations. 

In the Player scene, delete the Sprite node and replace it with an AnimatedSprite node. 
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In the inspector, create a new sprite frames resource. The SpriteFrames window will then pop-

up. 

 

 
 

In the animations list there will be an animation called default. Double click on it and rename it 

to IdleDown. For this animation, we're going to drag in the player_s_0 sprite. 
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From here, we can create the rest of the animations. These will be: 

 

• IdleDown (already created) 

• IdleUp 

• IdleLeft 

• IdleRight 

• MoveDown 

• MoveUp 

• MoveLeft 

• MoveRight 

 

Here's what the MoveDown animation will look like. Click on the New Animation button to 

create a new animation. 

 

 
 

 

Go through now and create all of the idle and move animations. Once that's done, select 

the AnimatedSprite node and... 
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• Set the Animation to IdleDown 

• Enable Playing 

 

 
 

 

Back in the Player script, let's create a new variable to reference the animated sprite node. 

 

 

 
 

 

Then we can create the manage_animations function which will check the velocity and facing 

directions to determine which animation to play. 
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The play_animation function will take in an animation name and play that. 

 

 
 

We can call the manage_animations function every frame at the end of the _physics_process 

function. 
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Now when we press play, you should see that the animations play when we move around. 

Creating the Tilemap 

Now that we've got a player who can walk around, let's create our world. 

 

In the MainScene, create a new child node of type TileMap. Then in the inspector, create a 

new tileset. 

 

 
 

These tile sets require tiles, so to do this, we need to create a new scene with all the available 

tiles in it. 
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Once all the tiles are in the new scene, go to Scene > Convert To... > Tile Set and save it as 

tileset.tres. 

 

Back in the MainScene, select the TileMap node and in the inspector, select the tileset property 

and choose load. Select the resource we just made and the tiles should appear in the panel to 

the right. 

 

 
 

We can now select a tile and paint it in the scene view. Here are some keys for building your 

tilemap: 
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• Place tile - Left Mouse 

• Delete tile - Right Mouse 

• Draw line - Shift + Left Mouse 

• Draw rectangle - Shift + Ctrl + Left Mouse 

• Delete line and delete rectangle are the same but with right mouse 

 

 

 
 

 

Now if we try to place a tree, you'll see that it replaces the tile rather than placing it on top. To fix 

this, we can create a second tilemap. 

 

• Call the existing tilemap TileMap_Ground 

• Create a new tilemap called TileMap_Above 

• Set that tileset to the same tileset 

• We can now draw tiles on-top of the existing tilemap 

 

https://academy.zenva.com/product/godot-game-development-mini-degree/?zva_src=godottutorials-godotbeginners-ebook


 
This book is brought to you by Zenva - Enroll in our Godot Game Development Mini-Degree to master 2D 

and 3D game development with the free, open-source Godot game engine 

© Zenva Pty Ltd 2020. All rights reserved 

 

 
 

Something you might also want is a collision with some tiles. To implement this, select the 

tilemap in the file system and the TileSet panel should pop up. 

 

• Select a tile 

• Click on the sprite that pops up (a bunch of settings should then appear) 

• Select Collision 

• Select the Rectangle tool 

• Draw the collider on the sprite 
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Let's now create a larger scene with our two tilemaps. 

 

 

Continued in Part 2 

With the tilemap created and player set up, we now have the basis for a spectacular 2D RPG in 

Godot!  Over the course of part 1, we've covered not only setting up sprite animations for your 

player character in Godot, but also setting up raycasts and tilemaps with appropriate 

collisions.  Fortunately, with just these foundations, you can expand into other games as well, or 

create even more complicated RPG maps. 

 

Nevertheless, our RPG certainly isn't complete!  In Part 2, we'll cover the rest of our RPG 

creation process with enemies, loot, UI systems, and more!  Hope to see you then! 
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Build a 2D RPG in Godot - Part 2 

Introduction 

Welcome back everyone!  It's time to finish our 2D RPG in Godot! 

 

For Part 1 of this tutorial series, we started setting up our 2D RPG project in the open-source 

and free Godot game engine.  Some of the things we learned about include: tilemaps, player 

controllers, raycasting, sprite animations, and more!  All in all, we have a great base to work 

with and expand on! 

 

However, what's an RPG without some enemies or items to loot?  In this second part of our 2D 

RPG tutorial for Godot, we'll finish by adding these elements, as well as adding the ability for 

our camera to follow the player. 

 

So sit back, and prepare yourself to finish your first RPG in Godot! 

 

Project Files 

For this project, we'll be needing some assets such as sprites and a font. These will be sourced 

from kenney.nl and Google Fonts. You can, of course, choose to use your own assets, but for 

this course we'll be using these. 

 

The assets and source code can be downloaded here. 

 

Camera Follow 

With our big scene, there's one problem which is the fact that the camera doesn't move. To fix 

this, let's create a new Camera2D node in the MainScene. 
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Then we can create a new script attached to the camera node. Call it CameraFollow. All we're 

going to do here is find the player and move towards them every frame. 

 

 

 
 

 

Finally, in the inspector make sure to enable Current so that the camera will be the one we look 

through. 
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Now if we press play, you'll see that the camera follows the player. 

Creating an Enemy 

Let's now create an enemy scene. These will chase after the player and attack them when in 

range. 

 

1. Create a new scene with a root node of KinematicBody2D 

2. Rename it to Enemy and save the scene 

3. Drag in the player_s_0.png sprite to create a sprite node 

4. Set the Modulate to red 

5. Create a CollisionShape2D node with a capsule shape and resize it 

6. Create a Timer node - this will be used for checking for when we can attack 
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Scripting the Enemy 

On the enemy node, create a new script called Enemy. We can start with the variables. 
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Inside of the _physics_process function (gets called 60 times per second) we want to move 

towards the target if we're further than the attack distance but closer than the chase distance. 

 

 
 

Back in the MainScene let's drag in the Enemy scene to create a new instance. Now we can 

press play and test it out. The enemy should move towards us. 

 

 
 

 

Now that the enemy moves towards us, let's have it attack us. 
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1. Go to the Enemy scene 

2. Select the Timer node 

3. In the Inspector panel, click on the Node tab 

4. Double click on the timeout() signal 

5. Click Connect 

 

 
 

This will create the _on_Timer_timeout function. Here, we want to check if we're within the 

attack distance and then attack the target. We'll be creating the take_damage function on the 

player soon. 

 

 

 
 

 

In the _ready function which gets called once the node is initialized, let's setup the timer node. 
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Finally for the enemy, let's create the take_damage and die functions. The target.give_xp 

function will be called over on the player script later on. 

 

 

Player Functions 

Now we want to go over to the Player script and add in some new functions to work with the 

enemies. Let's start with the give_gold function which will add gold to the player. 

 

 
 

For the levelling system, let's create the give_xp and level_up functions. 
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The take_damage and die functions will be called when an enemy attacks us. 

 

 
 

Now if we press play, you'll see that the enemy can attack and kill us - which will reload the 

scene. 
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Player Interaction 

With our player, we want the ability to interact with chests and enemies. In the Player script, 

let's create the _process function (called every frame) and check for when we're pressing the 

interact button. 

 

 
 

The try_interact function will check to see if the raycast is hitting anything. If it's an enemy, 

damage them but if it's not - call the on_interact function if they have it. 

 

 

Chest Interactable 

Now we need something to interact with. This is going to be a chest which will give the player 

some gold. Create a new scene with a root node of Area2D. 

 

1. Rename the node to Chest 

2. Save the node 

3. Drag in the rpgTile163.png to create a Sprite node 

4. Create a CollisionShape2D node 

5. Set the shape to a Rectangle and resize it to fit the sprite 
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Next, create a new script called Chest attached to the Area2D node. All we're going to do here, 

is have the on_interact function which gives the player gold then destroys the node. 

 

 

 
 

 

You might notice that interacting with the chest wont work but attacking the enemy does work. 

So in the Player scene, select the ray cast node and enable Collide With Areas. 
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Creating the UI 

Create a new scene with a root node of Control. 

 

1. Rename the node to UI 

2. Save the scene 

3. Create a new TextureRect node and call it BG 

4. Set the Texure to UI_Square.png 

5. Enable Expand 

6. Drag the 4 anchor points down to the bottom center 

7. Set the Position to 386, 520 

8. Set the Size to 250, 60 

9. Set the Visibility > Self Modulate to dark grey 
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As a child of this BG node, we want to create three new nodes. 

 

• LevelBG - TextureRect 

• HealthBar - TextureProgress 

• XpBar - TextureProgress 

 

 

For the TextureProgress nodes... 

 

1. Enable Nine Patch Stretch 

2. Set the Under and Progress textures to UI_Square.png 

3. Set the Under tint to dark grey 

4. Set the Progress tint to red or green 
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Now we need to setup our fonts. With the assets we imported into the project, we have two font 

files. Right now, these are just .ttf files which need to be converted in a format that Godot can 

read. For each font file... 

 

1. Right click it and select New Resource... 

2. Select the DynamicFont resource 

3. Save this to the Font folder 

4. Double click on the new resource and drag the .ttf file into the Font > Font Data property 
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As a child of the LevelBG node, create a new Label node and rename it to LevelText. 

 

• Resize the rect box to fit the level BG square 

• Set Align and Valign to Center 

• Drag the bold dynamic font resource into the Custom Fonts property 

• Set the font Size to 35 

• Set the Visibility > Self Modulate to grey 

 

 
 

Create a new Label node called GoldText. 

 

1. Move and resize it to look like below 

2. Set Align to Center 

3. Set the Custom Font to the regular dynamic font resource 

 

Scripting the UI 

Next up, let's create a new script attached to the UI node, called UI. We'll start with the variables 

to reference the children nodes. 
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Then we have our functions which update each of these nodes. 

 

 
 

Now that we have the UI script, let's go over to the MainScene and drag the UI scene in. To 

make it render to the screen, we need to create a CanvasLayer node and make UI a child of it. 
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In order to be able to access the UI script for the player, we need to move the canvas layer up 

to the top of the hierarchy. 
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Over in the Player script, let's create a variable to reference the UI script. 

 

 
 

Create the _ready function which gets called once the node is initialized. In there, we'll be 

initializing the UI. 

 

 
 

Now we need to go through a few functions and call the UI functions at the end of them. They 

go as following: 
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We can now press play and see that the UI is set at the start of the game and changes as we 

get gold, take damage, get xp and level up. 

 

With all of this, we're finished with our RPG game in Godot. Let's now go back to 

the MainScene and place some enemies and chests around the place. 

 

 
 

Conclusion 

Congratulations on completing the tutorial! Through perseverance, hard work, and a little bit of 

know-how, we just created a 2D RPG in Godot with a number of different features.  Over the 

course of Part 1 and Part 2, we've shown you how to set up: 

 

• A top-down 2D player controller 

• Enemies who can attack and chase the player 

• Chests we can interact with to get gold 

• A UI to show our health, XP, level, and gold 

 

And with that, you should now possess the fundamental skills to create even more RPGs in the 

future!  Of course, you can expand upon the game created here - adding in new features, 

fleshing out current ones, or even just improving certain aspects you felt were lacking!  There 

are endless directions to go from here, but with this solid foundation, you'll have quite the 

headstart! 
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Thank you very much for following along, and I wish you the best of luck with your future games. 
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Develop a 3D Action RPG in Godot - Part 1 

Introduction 

Ready to create your own game with some action-oriented gameplay? 

 

In some of our previous tutorials, we covered making a 3D FPS and a 2D RPG.  Both are well-

loved genres in the gaming industry and have a lot to offer players in terms of entertaining 

experiences.  However, what if you wanted a 3D RPG or maybe something with a little more 

spice to it?  For this tutorial, we're going to delve into just that and show you how to make a 3D, 

action RPG in the Godot game engine. 

 

This 3D action RPG tutorial will cover a lot of ground, including how to make: 

 

• A third-person player controller 

• Enemies who follow and attack the player 

• Melee combat system 

• Collectible coins 

• UI to show our health and gold 

 

If that sounds great to you, we hope you sit back and are eager to create your own action RPG 

from scratch! 

 

Before starting, please note that this tutorial won't be going over the basics of Godot.  If this is 

your first time learning the engine, make sure to check out the introductory tutorial first. 

 

Want to jump straight to making enemies and combat?  You can try out Part 2 instead! 

 

 

https://academy.zenva.com/product/godot-game-development-mini-degree/?zva_src=godottutorials-godotbeginners-ebook


 
This book is brought to you by Zenva - Enroll in our Godot Game Development Mini-Degree to master 2D 

and 3D game development with the free, open-source Godot game engine 

© Zenva Pty Ltd 2020. All rights reserved 

 

Project Files 

In this course, we're going to be using a few models and a font to make the game look nice. You 

can, of course, choose to use your own, but we're going to be designing the game with these 

specific ones in mind. The models are from kenney.nl, a good resource for public-domain game 

assets. Then we're getting our font from Google Fonts. 

 

You can download the source code and assets here. 

Project Setup 

To begin, let's create a new Godot project. First, we're going to import the assets we'll need. 

 

 
 

In the scene panel, select 3D Scene as our first root node. Rename the node to MainScene 

and save it to the file system. 

 

You'll see that we're in 3D mode here. In 3D, we have Spatial nodes. These are like Node2D's, 

but allow us to position, rotate and scale them in 3D space. Below you'll see we have a few 

different colored lines. 

 

• Blue line = Z axis 

• Red line = X axis 

• Green line = Y axis 
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Creating Our Environment 

Here in the MainScene, we're going to start off by creating our environment. 

 

1. Drag in the naturePack_001.obj model to create a new MeshInstance node 

2. Set the Translation to -15, 0, 15 

3. Set the Scale to 10, 1, 10 
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This is going to be our ground but we have one problem. There's no collider on the model so 

we're going to fall through it. To do this quickly, we can... 

 

• Select the node 

• Select Mesh > Create Trimesh Static Body 

 

 
 

Now that we have the ground, let's drag in the naturePack_019.obj model. 

 

• Give it a collider Mesh > Create Trimesh Static Body 

• Set the Translation to -12.6, 0.3, -4.7 

• Set the Scale to 8, 8, 8 
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We can then drag in more models, assign colliders to them and scale/position the nodes to 

create a nice looking environment. 

 

 
 

One thing you might notice is that the hierarchy is looking quite cluttered with all of these 

models. To fix this, we can create a new Node node and drag the models in as a child. This is 

the most simplistic type of node and is good for containers. We can then retract and expand the 

node when we need to. 
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Another thing you may notice is that it's quite dark. To fix this, we can create 

a DirectionalLight node which acts as our sun. 

 

1. Set the Rotation Degrees to -55, 65, 0 

2. Enable Shadow > Enabled 

 

Now we have light. 

 

 
 

Along with this, let's make the skybox look a bit nicer. Double click on the default_env.tres 

resource in the FileSystem to open up the options in the inspector. 

 

• Click on the Sky property to edit the skybox 

• Set the Top Color to pink 

• Set the Bottom Color to green 

• Set the Horizon Color to blue 

• Set the Curve to 0.1 
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Creating the Player 

Create a new scene with a root node of KinematicBody. This is a node for physics objects you 

want to walk around like a player or enemy. 

 

• As a child, create a new MeshInstance node 

o Set the Mesh to a Capsule 

o Set the mesh Radius to 0.5 

o Set the Translation to 0, 1, 0 

o Set the Rotation Degrees to 90, 0, 0 

• Another child is the CollisionShape node 

o Have the same properties as the mesh node 
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For the camera, we're going to have a center node with the camera as the child. 

 

• Create a new Spatial node and rename it to CameraOrbit 

• Set the Translation to 0, 1, 0 

• As a child of that, create a new Camera node 

• Enable Current 

• Set the Translation to -1, 1, -5 

• Set the Rotation Degrees to 0, 180, 0 
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For the sword, we're going to create a Spatial node called WeaponHolder. This will hold the 

sword model. 

 

• Set the Translation to -0.58, 1, 0.035 

 

As a child of this node, drag in the Sword.dae model. 

 

• Set the Rotation Degrees to 0, 90, 45 

• Set the Scale to 0.15, 0.15, 0.15 

 

 

 
 

 

For when we want to attack enemies, we'll need to create a RayCast node. Rename it to 

AttackRayCast. This shoots a point from a certain position in a direction and we can get info on 

what it hits. 

 

• Enable Enabled so that the ray will work 

• Set the Cast To to 0, 0, 1.5 

• Set the Translation to -0.3, 1, 0.6 
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Back in the MainScene, let's drag in the Player scene. 
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Camera Look 

 

Now that we've got our player object, let's start to script the camera look system. In the Player 

scene, select the CameraOrbit node and create a new script called CameraOrbit. We can start 

with the variables. 

 

 
 

The _input function gets called when any input is detected (keyboard, mouse key, mouse 

movement, etc). We want to check if the mouse moved, and if so - set the mouse delta. 

 

 
 

Inside of the _process function (called every frame), we're going to rotate the camera vertically 

and rotate the player horizontally. Rotating the player separately makes it easier later on to 

figure out movement directions. 
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Finally, we can lock and hide the mouse cursor in the _ready function. 

 

 
 

Now if we press play, it's going to ask us to select a base scene. Choose the MainScene then 

we can test out the camera orbit system. 

 

Scripting the Player 

Let's now get working on our player. Create a new script called Player attached to the Player 

node. We can start with the variables. 
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Now we're going to be detecting keyboard inputs and basing the movement on that. In order to 

get these inputs though, we need to create actions. Let's go to the Project Settings window 

(Project > Project Settings...) then go to the Input Map tab. 

 

Here, we want to enter in an action name and add it. Then assign a key to that action. We need 

6 different actions. 

 

• move_forwards 

o Key = W 

• move_backwards 

o Key = S 
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• move_left 

o Key = A 

• move_right 

o Key = D 

• jump 

o Key = Space 

• attack 

o Mouse Button = Left Button 

 

 
 

Back in our script, we can create the _physics_process function. This is built into Godot and 

gets called 60 times a second - this is good for doing physics calls. 
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Inside of this function, we're first going to reset the x and z axis' of our velocity vector and create 

a new vector to store our inputs. 

 

 
 

Then we can detect our movement actions and modify the input vector. 

 

 
 

With our input vector, we want to normalize it. This means resizing the vector to a magnitude (x 

+ y + z = magnitude) of 1. Because when we move forward, our input vector is (0, 0, 1) with a 

magnitude of 1. Yet when we move diagonally (1, 0, 1) we have a magnitude of 2. We move 

faster diagonally, so reducing our diagonal input vector to something like (0.5, 0, 0.5) will 

maintain a magnitude of 1. 

 

 
 

Now since we can look around and rotate, we don't want to move along the global direction. We 

need to find our local direction. 
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Next, we can apply this to our velocity vector. 

 

 
 

So we can move horizontally, but what about gravity? 

 

 
 

Along with gravity, we also want the ability to jump. 

 

 
 

Finally with everything calculated, let's actually move the player. 

 

 
 

We can now press play and test it out! 
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Gold Coins 

 

Next up, we're going to create a coin object which the player can collect. 

 

1. Create a new scene with a root node of Area 

2. Rename the node to GoldCoin 

3. Save it to the file system 

4. Drag in the GoldCoin model as a child 

5. Set the Scale to 0.5, 0.5, 0.5 

6. Create a new CollisionShape node 

7. Set the Radius to 0.5 

 

 
 

Attached to the Area node, create a new script called GoldCoin. First, we can work on our two 

variables. 

 

 
 

Inside of the _process function which gets called every frame, we'll rotate the coin along its Y 

axis. 
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In order to detect when the player has entered the coin, we need to connect to a signal. 

 

1. Select the GoldCoin node 

2. In the Node tab, double click on the body_entered signal 

3. Click Connect and you should see that a new function is created in the script 

 

 

 
 

 

This function gets called when another body enters the coin collider. What we want to do is 

check to see if the body is the player. If so, call the give_gold function (which we'll create after) 

and then destroy the node with queue_free. 
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Let's now create the give_gold function over in the Player script. 

 

 
 

Back in our MainScene, let's drag in the GoldCoin scene. Duplicate it multiple times to create a 

number of different instances and position them around. 
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Just like with the models, let's create a new empty Node and make the coins a child of it. This 

will act as a sort of container to make the scene hierarchy less cluttered. 

 

 

Continued in Part 2 

So far, we've created a player with a sword, scripted our player to move, and even set up our 

various coins that the player will try to collect.  To boot, we also set up our camera so that it can 

follow the player.  While some aspects certainly are playable in this state, our 3D action RPG is 

definitely not complete!  After all, what is an RPG without some enemies and obstacles to face 

off against? 

 

In Part 2, we'll finish up this 3D action RPG project by setting up our enemies, animating our 

sword for combat, and implementing our UI.  In so doing, we'll have a solid foundation for an 

RPG that can be expanded upon as you wish!  Until the next part! 
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Develop a 3D Action RPG in Godot - Part 2 

Introduction 

Welcome back to this tutorial series where we're building a 3D action RPG from scratch with 

Godot.  In Part 1, we covered a lot of ground with how to make an action RPG with Godot, 

including: 

 

• Creating the project 

• Setting up the environment 

• Implementing the third-person player controller 

• Building collectible gold coins 

 

While these elements certainly create a great foundation for our game, we'll want to add just a 

bit more to create that true, action RPG feel.  Thus, in Part 2, we'll be finishing our project by 

adding enemies and combat mechanics - including a nifty animation for our sword.  To boot, 

we'll also dive into the Godot UI so that you can set up a simple way to track the player's health 

and gold. 

 

We hope you're ready to dive in and create this impressive piece for your portfolio! 

Project Files 

In this course, we're going to be using a few models and a font to make the game look nice. You 

can, of course, choose to use your own, but we're going to be designing the game with these 

specific ones in mind. The models are from kenney.nl, a good resource for public-domain game 

assets. Then we're getting our font from Google Fonts. 

 

You can download the source code and assets here. 

Creating the Enemy 

Let's now create the enemy. They will chase after the player and damage them at a specified 

distance. To begin, let's create a new scene with a root node of KinematicBody. 

 

1. Rename the node to Enemy 

2. Save the scene 

3. As a child, create a new MeshInstance node (rename it to Mesh) 

4. Set the Mesh to CapsuleShape 

5. Set the Radius to 0.5 

6. Set the Mid Height to 1.5 

https://academy.zenva.com/product/godot-game-development-mini-degree/?zva_src=godottutorials-godotbeginners-ebook
https://www.kenney.nl/
https://fonts.google.com/
https://godottutorials.pro/action-rpg-godot-tutorial-part-2/


 
This book is brought to you by Zenva - Enroll in our Godot Game Development Mini-Degree to master 2D 

and 3D game development with the free, open-source Godot game engine 

© Zenva Pty Ltd 2020. All rights reserved 

 

7. Set the Transform > Translation to 0, 1.25, 0 

8. Set the Transform > Rotation Degrees to 90, 0, 0 

 

 
 

Let's differ this capsule from our player. Just under where we set the radius. we can create a 

new SpatialMaterial. Click on that to open up the material properties. 

 

• Set the Albedo > Color to red 
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Next, we can create a CollisionShape node with the same properties as the mesh. 

 

1. Set the Shape to CapsuleShape 

2. Set the Radius to 0.5 

3. Set the Height to 1.5 

4. Set the Translation to 0, 1.25, 0 

5. Set the Rotation Degrees to 90, 0, 0 

 

 
 

Finally, we're going to create a Timer node which can send out a signal every certain amount of 

seconds. This will be setup in-script. 
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Scripting the Enemy 

Now, we're going to create the enemy script. Select the Enemy node and create a new script 

called Enemy. First, we want to enter in our variables. 

 

 

 
 

 

First, we're going to create the _ready function which gets called once the node is initialized. 

Inside of here, we're going to set the timer wait time and start it. 
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But nothing will happen right now because the timer isn't connected to anything. So select the 

node and in the Node tab, we want to connect the timeout() signal to the script. 

 

1. Double click the timeout signal 

2. Click Connect 

3. Now you should see that there's a new function in the enemy script 

 

 

 
 

 

With the new function, let's check our distance to the player and damage them. We'll create the 

take_damage function on the player soon. 
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Next, let's implement the ability for the enemy to chase after the player when further than the 

attack distance. 

 

 

 
 

 

Let's finish of the enemy script with the take_damage and die functions. The take damage 

function will be called when the enemy is attacked by the player. 
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Our enemy is now finished. We've got all the functions setup, so let's now go over to the Player 

script and create the functions which get called by an attacking enemy. 
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We can now go to the MainScene and drag the enemy scene in to create a new instance. 

Press play and the enemy should chase after you. 

Sword Animation 

Now its time to implement the ability to attack enemies. Before we jump into scripting, let's 

create an animation for the player's sword. In the Player scene, right click on 

the WeaponHolder and create a new child node of type AnimationPlayer. Rename it 

to SwordAnimator. 

 

 
 

Selecting the node should toggle the Animation panel at the bottom of the screen. Here, we 

want to click on the Animation button and create a new animation called attack. 

 

 
 

https://academy.zenva.com/product/godot-game-development-mini-degree/?zva_src=godottutorials-godotbeginners-ebook


 
This book is brought to you by Zenva - Enroll in our Godot Game Development Mini-Degree to master 2D 

and 3D game development with the free, open-source Godot game engine 

© Zenva Pty Ltd 2020. All rights reserved 

 

With the animator, we can choose which properties we want to animate. Select the 

WeaponHolder, and in the inspector select the key icon next to Rotation Degrees. Create that 

new track. 

 

 
 

 

By default the FPS of the animation is quite low, so select the Time drop-down and change that 

to FPS. Set the FPS to 30. 

 

 

 
 

 

Now we can right-click on the tack and insert a new key. Selecting the key, we can change the 

rotation with the Value property. 
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Here's the attack animation I made. 
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Attacking the Enemy 

Now that we have the attack animation, let's go ahead and start scripting it. In the Player script, 

let's create the _process function which gets called every frame. 

 

 
 

The try_attack function will check to see if we can attack and if so, damage the enemy. 

 

 
 

First, we want to see if we can attack based on the attack rate. We're getting the current time 

elapsed in milliseconds. That's why we're multiplying attackRate by 1000. 

 

 
 

Then we want to set the last attack time and play the animation. 

 

 

https://academy.zenva.com/product/godot-game-development-mini-degree/?zva_src=godottutorials-godotbeginners-ebook


 
This book is brought to you by Zenva - Enroll in our Godot Game Development Mini-Degree to master 2D 

and 3D game development with the free, open-source Godot game engine 

© Zenva Pty Ltd 2020. All rights reserved 

 

 

To actually attack the enemy, we need to check to see if the raycast is detecting an enemy. 

 

 
 

We can now press play and test it out. Try attacking the enemy and eventually they should 

disappear, showing that our system works. 

Creating the UI 

Now that we have all of the systems in place, the final thing to do is implement the user 

interface. This will include a health bar and gold text. So to begin, let's create a new scene of 

type user interface (Control node). Rename it to UI and save the scene. 

 

 
 

As a child, create a new TextureProgress node. This is a texture which can resize like a 

progress bar. 

 

https://academy.zenva.com/product/godot-game-development-mini-degree/?zva_src=godottutorials-godotbeginners-ebook


 
This book is brought to you by Zenva - Enroll in our Godot Game Development Mini-Degree to master 2D 

and 3D game development with the free, open-source Godot game engine 

© Zenva Pty Ltd 2020. All rights reserved 

 

1. Rename the node to HealthBar 

2. Enable Nine Patch Stretch 

3. Set the Under and Progress textures to UI_WhiteSquare.png 

4. Set the Under tint to dark grey 

5. Set the Progress tint to red 

6. Bring the anchor points (4 green pins) down to the bottom left of the screen 

7. Drag the health bar down to the bottom left and resize it (drag on the circles to resize) 

 

 

 
 

 

For our gold text, we're going to need a font as the default one isn't that versitile. 

 

1. Right click on the .ttf file in the file system and select New Resource... 

2. Search for and select DyanamicFont 

3. This will create a new dynamic font resource 
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Double click the dynamic font, and in the inspector... 

 

1. Set the Size to 30 

2. Drag the .ttf file into the Font Data property 
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Now we can create a Label node and rename it to GoldText. This node will display text on-

screen. 

 

1. Drag it down above the health bar 

2. Set the anchor points to be bottom-left of the screen 

3. Drag the dynamic font asset into the Custom Font property on the label 

 

 
 

Now that we have our UI, let's go to the Player scene and create a child node 

called CanvasLayer. This is a node which renders the control node children to the screen. So 

as a child of the canvas layer, drag in the UI scene. 
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If we press play, you'll see that the UI is rendering on the screen. 

Scripting the UI 

 

We've got our UI displaying on-screen, but it doesn't do anything just yet. In the UI scene, 

create a new script attached to the UI node called UI. We can start with the variables. 

 

 
 

Then we can create the update_health_bar function. This will set the value of the texture 

progress. 

 

 
 

Finally, the update_gold_text function will update the text of the gold text label. 

 

 
 

Now that we've got the UI script created, let's go to the Player script and hook these functions 

up. 

 

Let's create a variable to reference the UI node. 
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Then inside of the _ready function (called when the node is initialized), we want to initialize the 

UI. 

 

 
 

Inside of the give_gold function, we can update the gold text. 

 

 
 

Inside of the take_damage function, we can update the health bar. 

 

 
 

And there we go. You can press play now and see that the UI will update when we take damage 

and collect coins. 

Conclusion 

Congratulations on completing the tutorial!  If you've been following along, you should now have 

a 3D action RPG playable within your Godot editor!  Over the course of both Part 1 and Part 2, 

we learned how to create: 

 

• A third-person player controller 

• Enemies who chase and attack the player 

• Player combat 

• Collectible coins 

• User interface 
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With that, you now have a fantastic project that you can share with your friends, add to your 

portfolio, or use as a base for your own projects.  As you can imagine, these systems can be 

expanded in numerous ways, such as adding more collectibles, adding different enemies, and 

beyond.  We encourage you to explore what Godot is capable of - but for now, we hope you 

enjoy this action RPG you've created with your own two hands! 
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Make a Strategy Game in Godot - Part 1 

Introduction 

Whether turn-based, real-time, or resource management based, strategy games remain 

cemented in the world as one of the most popular genres.  This is why numerous beginning and 

experienced developers alike dream of creating their own strategy games and building a 

balanced, challenging gameplay experience.  So, what if we told you that making your own 

strategy game was completely possible with Godot? 

 

If that sounds exciting, then this is the tutorial for you!  Through this tutorial, we're going to show 

you how to make a resource-based city building game with ease - all within the Godot game 

engine.  You will learn several features common to strategy games such as: 

 

• Making a turn-based system 

• Having three different buildings which product resources 

• Setting up a grid-based placement system 

• Using a UI to show resources, turn, etc. 

 

So, if you're ready, buckle down, turn on your computer, and get pumped to make a strategy 

game project with Godot. 

 

Before we begin though, it's important to know that this tutorial will not go over the basics of 

Godot. If you're new to the engine, we recommend you read through our introductory tutorial on 

the subject! 

 

Already know all this and want to jump into building placement and turn-based game flow?  Try 

out Part 2 instead! 
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Project Files 

In this tutorial, we'll be using some sprites from the kenney.nl website (an open domain game 

asset website) and fonts from Google Fonts. You can of course choose to use your own assets, 

but we'll be designing the game around these: 

 

You can download the source code and assets here. 

 

Setting up the Project 

Create a new Godot project and for our first scene, we're going to choose 2D Scene (Node2D 

node). Rename it to MainScene and save the scene to the file system. 

 

 

 
 

 

Let's also import our assets by dragging the two folders into the file system. 
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Something we also want to do is change the resolution of the screen. When we press play 

(you'll be asked to choose a base scene - select the MainScene), you'll see that the screen is 

pretty small. Due to our sprite size and the amount of tiles we're going to have, let's set the 

resolution. 

 

Open the Project Settings window (Project > Project Settings...) and go down to the Display > 

Window tab. 

 

• Set the Width to 1280 

• Set the Height to 720 

• Disable Resizable 
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Creating the Tiles 

We're going to start by creating the tile scene. This will contain the sprite, highlight, collider, 

script, etc. So create a new scene with a root node of Area2D. An Area2D node can detect 

collisions which is needed for selecting tiles later on. 

 

1. Rename the node to Tile 

2. Save the scene to the file system 
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We then want to create a few more nodes as a child of the main node. 

 

1. Drag in the Ground.png image to create a new Sprite node (make sure it's at a position 

of 0, 0) 

2. Drag in the TileHighlight.png image to create a new Sprite node 

a. Rename it to Highlight 

b. Set the Scale to 6.4, 6.4 

c. Click the eye to disable it by default 

3. Create a new Sprite node 

a. Rename it to BuildingIcon 

4. Create a new CollisionShape2D node 

a. Set the Shape to RectangleShape2D 

b. Set the Extents to 32, 32 

https://academy.zenva.com/product/godot-game-development-mini-degree/?zva_src=godottutorials-godotbeginners-ebook


 
This book is brought to you by Zenva - Enroll in our Godot Game Development Mini-Degree to master 2D 

and 3D game development with the free, open-source Godot game engine 

© Zenva Pty Ltd 2020. All rights reserved 

 

 
 

 

Back in the MainScene, let's drag in the Tile scene to create a new instance. To make it easier 

to position, enable Grid Snapping. 
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With the tile node selected, press Ctrl + D to duplicate it. Fill in a 20 by 9 area with tiles. This is 

going to be where we play the game and make sure that it's all contained within the blue box 

(the window). 

 

 

 
 

 

You may notice that the scene hierarchy is pretty cluttered. We have over 100 nodes which will 

make it harder to find other things that aren't tiles. In order to fix this, we can... 

 

1. Create a Node node (most basic node we'll use as a container) 

2. Rename it to Tiles 

3. Drag all the tile nodes in as a child 

4. With this, we can retract the children to hide them in the scene hierarchy 
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We haven't created the script for the tile yet, but next up is the UI. 

Creating the UI 

Our UI is going to be a bar at the bottom of the screen displaying our resources, turn and 

buttons. Create a new scene with a root node of type User Interface (Control node). 

 

1. Rename the node to UI 

2. Save the scene to the file system 

3. Set the Rect > Position to 0, 576 

4. Set the Rect > Size to 1280, 144 
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As a child of the UI node, create a ColorRect node. This is a control node that renders a certain 

color. 

 

1. Set the Color to dark grey 

2. Set the Size to 1280, 144 
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Before we continue, let's setup out fonts. In the Font folder, we have two .ttf files. For each font 

file... 

 

1. Right click the .ttf file and select New Resource... 

2. Create a new DynamicFont resource 

 

 

 
 

 

For each dynamic font resource... 

 

1. Double click on the DynamicFont resource 

2. Set the Size to... 

a. Regular = 30 

b. Bold = 35 

3. Drag the respective .ttf file into the Font Data property 
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Next, create a Button node and rename it as EndTurnButton. 

 

1. Set the Text to End Turn 

2. Set the Position to 1046, 34 

3. Set the Size to 200, 75 

4. Drag the bold dynamic font resource into the Custom Fonts > Font property 
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Create a new Label node and rename it to TurnText. 

 

1. Set the Text to a placeholder of Turn 257 

2. Set the Position to 878, 56 

3. Set the Size to 143, 36 

4. Drag the regular dynamic font into the Custom Fonts > Font property 

 

 

 
 

 

Next, we'll be creating the three building buttons. We're going to store these inside of a node 

which can automatically resize its children. Create a new HBoxContainer node and rename it 

to BuildingButtons. 

 

1. Set the Alignment to Center 

2. Set the Position to 34, 34 

3. Set the Size to 236, 75 
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As a child of the BuildingButtons node, create three Button nodes. You'll see that they 

automatically resize to fit the bounds of the BuildingButtons node. 

 

• MineButton 

• GreenhouseButton 

• SolarPanelButton 

 

For each button, set their Icon texture to their respective texture in the Sprites folder. 
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Create a new Label node and rename it to HeaderFoodMetal. 

 

1. Set the Text to Food: Metal: 

2. Set the Align to Right 

3. Set the Position to 368, 32 

4. Set the Size to 115, 75 

5. Set the Custom Font > Font property to the regular dynamic font 

 

 

 
 

 

Duplicate the node and rename it to FoodMetalText. 

 

1. Move it over to the right like in the image below 

2. Set the Text to a placeholder of 25 (+80) 25 (+80) 

3. Set the Align to Left 

4. Set the Custom Colors > Font Color to yellow/orange 
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Select the two labels and duplicate them. Rename them respectively to: 

 

• HeaderOyxgenEnergy 

• OxygenEnergyText 

 

Move them over to the right. Change the text of the header label to 'Oxygen: Energy:'. 
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There we go. Our UI is now complete, so let's go back to the MainScene and drag in the UI 

scene. 

 

 
 

Now if we press play, you'll see basically what the final game will look like - just without the 

functionality. 
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Tile Script 

To begin scripting, we'll create the Tile script. This will hold data and functions relative to each 

tile. In the Tile scene, select the Tile node and create a new script attached to it called Tile. 

We'll start with our variables. 

 

 
 

Next, let's create the _ready function - this gets called when the node is initialized. Here, we're 

going to add the tile to the "Tiles" group. A group in Godot can allow us to easily access and 

modify a group of nodes. 

 

 
 

The toggle_highlight function will toggle the highlight visual on or off, also toggling whether or 

not a building can be placed. 
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The place_building function gets called when we place a building on the tile. 

 

 
 

Next, we need to connect a signal to the script. The input_event signal gets emitted once an 

input is detected in the collider like a mouse click. So with the Tile node selected, go to 

the Node panel and double click the signal. Then connect it to the script. 
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This will create the _on_Tile_input_event function in the script. We need some other things 

implemented first, so let's just add pass to the function which means it's empty. 

 

 

Map Script 

The Map script will reference all our tiles and have the ability to highlight the available ones, get 

a tile at a given position, etc. In the MainScene, select the Tiles node and attach a new script 

called Map. We can start with our variables. 

 

 
 

The get_tile_at_position function will return the tile that is at the given position. 
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The disable_tile_highlights function loops through all the tiles and disables their highlight 

visual. 

 

 

 
 

 

The highlight_available_tiles function will highlight all of the tiles which can have a building 

placed on. This is the surrounding tiles of all buildings. First, we're going to loop through all tiles 

that have a building on it. 

 

 

 
 

 

Inside the for loop, we're first going to get the north, south, east and west tile relative to the 

current one. 

 

 

 
 

 

After this, we're going to check each of the tiles. If they're not null, enable the highlight. 
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We're not finished with the Map script yet, but we do need to work on a few other things first. 

BuildingData Script 

The BuildingData script isn't a script which is attached to a node. This is going to be a global 

class which can be accessed anywhere in the project. In the Script tab, go File > New Script... 

and create a new script called BuildingData. 

 

Then we need to go to the Project Settings (Project > Project Settings...) and click on 

the AutoLoad tab. 

 

1. Select the file button and find the BuildingData.gd script 

2. Click the Add button 

 

This will create a new singleton for the BuildingData script. 

 

 
 

Back in the BuildingData script, let's begin by creating a new class called Building. This is 

going to be an object to hold the data for each building. 
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We're using integers for the building type and resources. These integers refer to a specific thing. 

 

 

Building Types 

 

• Base = 0 

• Mine = 1 

• Greenhouse = 2 

• Solar Panel = 3 
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Resources 

 

• None = 0 

• Food = 1 

• Metal = 2 

• Oxygen = 3 

• Energy = 4 

 

Outside of the Building class, we can create 4 variables for each of our 4 buildings (Base, Mine, 

Greenhouse, Solar Panel). 

 

 
 

We'll be using these variables to know what each building produces, takes, the texture and 

other values. 

Continued in Part 2 

While there are certainly more elements to add, we've gone on quite the journey here so far!  As 

the basis of our game, we've already set up a grid-based tile system that will allow us to place 

buildings later and highlight tiles where applicable buildings can be played.  Additionally, we've 

also set up the buildings themselves which will provide the crucial resource management 

functionality to our game (along with an accompanying UI). 

 

While this is a great start in building a strategy game with Godot, we have a bit more to go!  In 

Part 2, we're going to finish off our map, create the ability to place the buildings, create the turn-

based gameplay flow, and beyond to connect all our features up to work as one, coherent game 

project!  See you then! 
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Make a Strategy Game in Godot - Part 2 

Introduction 

 

Welcome back to Part 2 of creating a strategy game in the Godot game engine! 

 

In Part 1, we began showing you how to build your first strategy game in Godot by setting up 

highlight-able tiles, buildings, and the basic UI which will tell the players crucial information 

about their resource management.  All in all, we have a great foundation to work with so we can 

finish our project and add it to our portfolio! 

 

Of course, with this being Part 2, there is still more go.  We need to finish up our map system, 

set up our UI properly, give ourselves the ability to place buildings, and even implement the 

overall turn-based gameplay flow.  So, if you're prepared, and let's finish this resource 

management game and become master Godot developers! 

Project Files 

In this tutorial, we'll be using some sprites from the kenney.nl website (an open domain game 

asset website) and fonts from Google Fonts. You can of course choose to use your own assets, 

but we'll be designing the game around these: 

 

You can download the source code and assets here. 

Finishing the Map Script 

To begin, let's go back to our Map script. The place_building function gets called when we 

want to place down a building on a tile. 
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Finally, the _ready function gets called when the node is initialized. Here, we want to get all of 

the tiles in the "Tiles" group and setup the initial base building. 

 

 
 

Back in the MainScene, let's select the center tile and enable Start Tile. 

 

 
 

Now if we press play, you should see that the center tile has a Base building on it. 
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GameManager Script 

 

The GameManager script is what's going to manage our resources and states. Go to 

the MainScene and select the MainScene node. Create a new script attached to it 

called GameManager. We can start with our variables. 
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The on_select_building function gets called when we press one of the three building UI 

buttons. This will be hooked up later on when we create the UI script. 
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The add_to_resource_per_turn function adds the given amount to the given resource per turn. 

 

 
 

The place_building function will be called when we place down a tile on the grid. 
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Finally, we have the end_turn function which gets called when we press the end turn button. 

 

 
 

Okay so we've got our GameManager class all setup but there's no real way for it to function. In 

order to connect everything together, we need to create a UI script. 

UI Script 

In the UI scene, select the UI node and create a new script called UI. Let's start with our 

variables. 
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First, we have the on_end_turn function. This gets called when a turn is over, so we're going to 

reset the UI. 

 

 
 

The we have the update_resource_text function which updates the two resource labels to 

show the player's current resource values. 
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Now we need to connect the buttons. In the UI scene, do the following for the EndTurnButton, 

MineButton, GreenhouseButton and SolarPanelButton... 

 

1. Select the button node 

2. Double click the pressed signal (called when we press the button) 

3. Connect that to the UI script 

 

 
 

So back in our script, we'll have 4 new functions. Let's start with the three building buttons. 
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Then we have the end turn button function. 

 

 

Connecting Everything Together 

Now that we have our UI script, let's go back to the Tile script and fill in 

the _on_Tile_input_event function. 
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Next, let's hop into the GameManager script and create the _ready function. Here, we're going 

to initialize the UI. 

 

 
 

At the end of the end_turn function, let's also update the UI. 

 

 
 

Finally, at the bottom of the place_building function, we can update the resource text UI. 

 

 
 

Now we can press play and test out the game! 
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Conclusion 

Congratulations on completing the tutorial! 

 

You just created a 2D, turn-based strategy game in Godot.  Through this journey, we've covered 

a wide array of topics, from setting up objects that give and take resources, to creating a tile-

based map that provides visual clues about where buildings can be placed.  Further, with turn-

based gameplay mechanics also introduced, we've tackled a key component for many other 

sorts of strategy games as well! 

 

From here, you can expand upon what you've learned to add more systems, work on existing 

ones we touched on here, or even start a new strategy game project with Godot. Regardless, 

thank you very much for following along with the tutorial, and we wish you the best of luck with 

your future Godot games. 
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